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A mesh comprises a set of triangles (typically in three dimensions) 

that are connected by their common edges. You can manipulate and 
edit the individual triangles. 

The mesh functionality that is available is controlled by the product 
licence.  

 PowerSHAPE provides basic triangle modelling functionality. 

 PowerSHAPE Pro provides the following: 

 PowerSHAPE. 

 additional triangle modelling features. 

 reverse engineering features. 

 re-engineering features. 

Use the licencing table (see page 4) to identify the functionality that 

is available with different licences.  

 

Mesh modelling 
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Licencing of cloud and mesh modelling 
functionality 

Use the following table and legend to see the triangle modelling 
functionality that is available with each licence. 
 Not available 

 Available 

 

Tool PS Designer PS Pro 

Mesh Edit toolbar    

 Add triangles (see page 82)     

 Draft mesh (see page 20)    

 Thicken mesh (see page 21)    

 Reduce (see page 22)    

 Refine (see page 23)    

 Smooth (see page 26)    

 Divide (see page 61)   
   

 Reverse (see page 65)    

 Hole filling (see page 73)    

 Mesh Doctor (see page 66)    

 Stitch (see page 76)    

 Remove overlaps (see page 
77) 

   

 Z-compensation (see page 
78) 

   

 Mask (see page 79)    

 Delete (see page 83)    

 Paint (see page 27)    

 Morph (see page 28)    

 Pick (lasso (see page 

10)/select (see page 17)) 

   

Cloud toolbar    

 Generate mesh    
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Tool PS Designer PS Pro 

 Delete points    

General Edits toolbar    

 Mesh/point cloud alignment    

 Mesh limiting    

 Cloud limiting    

 Align items    

 Sculpt (see page 85)    

 Mesh offset    

Curve toolbar    

 Oblique mesh     

 Draft/horizon mesh    

 Curves from intersections 
with meshes 

   

 Curve from discontinuities 

(see page 105) 

   

 Curve from boundaries (see 

page 106) 

   

 Fit curves to mesh    

Surface/Solid/Solid Feature 
toolbar 

   

 Fit surface to mesh    

 Convert surfaces/solid to 

mesh (see page 100) 

   

 Import mesh as solid (see 
page 6) 

   

 Convert mesh to solid (see 

page 102) 

   

 Booleans with meshes (see 

page 110) 

   

Combine (Object > Mesh 
menu) (see page 92)  

   

Triangle/edge shading options 

(Views toolbar) (see page 93)  

   

Error analysis (Model analysis 

toolbar)  
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Tool PS Designer PS Pro 

Splitting using painted regions     

Import Point Cloud     

Import CCAD session     

 Divide by selection is available only in PowerSHAPE Pro. 
 

Importing a mesh 
To import a mesh (.stl or .dmt file type): 

1 Click the Import  button to display the Select a File To Import 

dialog. 

2 Select a file and click Open. 
 

Selecting meshes 
Use one of the following methods to select a mesh: 

 Filters (see page 7) 

 Context menu 
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Select all triangles — Select this menu option to select all 

triangles. 

Invert selection — Select this menu option to invert the triangle 

selection. 

Clear selection — Select this menu option to clear the triangle 

selection. 

 Select a specific area of a mesh using the Mesh edit toolbar. 
 

Selecting meshes using filters 

Use the filters to select meshes in one of the following ways: 

 Use Quick select all meshes  from the Select flyout to select all 

the meshes in a model. 

 

Alternatively, select Edit > Select > Quick Select > Meshes from the 

menu. 
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 Use the Selection Filter or Manually Select options on the Edit > 

Select menu.  
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Editing a mesh using the Mesh Edit 
toolbar 

Use the Mesh Editing options to modify your meshes. 

1 Select one or more meshes to display the Mesh Edit toolbar. 

 

2 Click one of the following to edit the selected meshes: 

 Lasso (see page 10) 

 Picking visibility (see page 14) 

 Select triangles (see page 17) 

 Draft wall (see page 20) 

 Thicken mesh (see page 21) 

 Reduce the number of triangles. (see page 22) 

 Refine mesh (see page 23) 

 Smooth mesh (see page 26) 

 Smooth normals (see page 97) 

 Paint triangles (see page 27) 

 Morph mesh (see page 28) 
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 Segment mesh (see page 46) 

 Shrink-wrap a surface onto a mesh (see page 58) 

 Divide a mesh into multiple meshes (see page 61). 

 Reverse triangles in the selected meshes (see page 65). 

 Open the Mesh Doctor to fix faults in the mesh (see page 

66). 

 Fill Holes (see page 73). 

 Stitch the selected meshes (see page 76). 

 Resolve overlapping triangles in the selected meshes (see 

page 77). 

 Z compensation tool (see page 78). 

 Mask triangles (see page 79). 

 Add triangles (see page 82). 

 Delete triangles (see page 83). 

The options can also be selected from the Object > Mesh menu. 
 

Picking method 

Use this flyout to define the boundary of the area of triangles to be 
picked. 

 

1 Select the required picking method from the flyout. 

 
Select by 

box 
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Continuous 

lasso (see 
page 11) 

 
Discrete 
lasso (see 

page 12) 

2 Use the selected method to pick the triangles on the mesh. 

3 Deselect the picking method by clicking the button on the 
toolbar. Alternatively, click the Select button on the left-hand 

toolbar. 

Modifier keys 

Use the following modifier keys with box, continuous lasso, and 
discrete lasso triangle picking modes: 

No modifier  Replace 

 Add 

 Invert 

 and  Remove  

 
 

Continuous lasso 

Use the Continuous Lasso to select individual triangles on the 

model. 

1 Select the Lasso Picking  button. 

2 Click the start point on the model. 
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3 Click the model to create points to anchor the lasso. The lasso 

links the anchor points with straight lines. 

 

 To delete the last anchor point from the lasso, press Ctrl as 

you click anywhere on the model. 

4 When the lasso line encloses the entities you want to select, click 
on the starting point to create a closed selection polygon. 

The selection polygon is projected down the current view to 
select all the entities under the polygon. 

 

 When using the lasso to select triangles, only part of the 

triangle needs to be under the polygon in order to be 

selected. 
 

Discrete lasso 

Use  to pick triangles on a mesh using discrete lasso: 

1 With an active mesh, select the Discrete Lasso  button from 

the lasso flyout. 

2 Click the mesh to define the points on the boundary of the 
picking area. 
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 Undo your most recent point by hovering over it. When the 

cursor changes to , click on the point to remove it. 

 

3 Move the cursor over the first point you entered. The cursor 

changes to . 

4 Click the first point to complete the lasso, selecting the triangles 

within the polyline. 

All the triangles that lie within picking area are selected. 

 

 Press and hold Ctrl and click , or press and hold Shift and 

click  away from the model to deselect the selected 

triangles, but leave the mesh selected. 

Use Ctrl+D to deselect the selected triangles and the model. 
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Picking visibility 

Use Picking visibility flyout to specify the triangles that are visible.  

 

The following example shows the effect of using the options on the 
Picking visibility flyout: 

 

1 Select the mesh to display the Mesh Edit toolbar. 

2 Click  option from the Picking flyout . 

 

3 Select one of the following options from the Picking visibility 

flyout . 

  Select all triangles on top — Select this button to pick the 

triangles (visible and invisible) in the top part of the mesh. 

  Select visible triangles on top — Select this button to pick 

the visible triangles in the top part of the mesh. 
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  Select all triangles — Select this button to pick all the 

triangles (visible and invisible) in the selected part of the 

mesh. 

4 Box-select an area of the model. 

 

5 Rotate the model to see the selected triangles: 

 Using the Select all triangles on top  button, the resulting 

selection is: 
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 Using the Select visible triangles on top  button, the 

resulting selection is: 

 

 Using the Select all triangles  button, the resulting 

selection is: 
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Select triangles 

Use the Select triangles flyout to select triangles on a mesh. 

1 With a mesh active, click  to display the buttons on the Select 

triangles flyout. 

 

2 Select one of the following options from the Select triangles 

flyout: 

 Select triangles with the same colour 

 Select triangle area to discontinuity angle (see page 18) 

 Select triangle area to local horizon angle (see page 18) 

 Select triangle area to distance (see page 20) 
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Select triangle area to discontinuity angle 

1 Select a mesh and click  to display the Select Triangles flyout. 

2 Click the Discontinuity Angle  button to display the Set angle 

dialog. 

 

3 Click the model. Triangles are selected that lie within the 

discontinuity angle defined by the slider. Use the slider to 
increase or decrease the triangles that are selected. The example 

shows a cone with a 15  angle. 

 

   

 
   

   

       

 
 

Select triangle area to local horizon angle 

1 Select a mesh and click  to display the Select Triangles flyout. 
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2 Click the Local Horizon Angle  button to display the Set angle 

dialog. 

 

3 Click the model. 

 

Triangles are selected that lie within the angle defined by the 
slider in the Set angle dialog. 

4 Use the slider to increase or decrease the triangles that are 
selected. 
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Select triangle area to distance 

1 Select a mesh and click  to display the Select Triangles flyout. 

2 Select the Area to Distance  button to display the Set Distance 

dialog. 

 

3 Click the model. 

 

Triangles are selected that lie within the distance defined by the 
slider in the Set distance dialog. 

4 Use the slider to increase or decrease the triangles that are 

selected. 

 

 
 

Create draft wall 

This option is available only when using Delcam Designer or 
PowerSHAPE Pro. 

1 Select one or more meshes to display the Mesh Edit toolbar. 
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2 Click the Draft  button to display the Create Draft dialog. 

 

3 Enter a value for the Draft angle. 

4 Select Create walls only to create the draft walls and remove the 

original triangles. 

5 Click OK. 
 

Thicken mesh 

This option is available only when using Delcam Designer or 
PowerSHAPE Pro. 

You can thicken meshes inwards, outwards, or in both directions. 
The default setting is to thicken in both directions, so that the 

original item is in the middle. 

To thicken a mesh: 

1 Select one or more meshes to display the Mesh Edit toolbar. 

2 Click the Thicken  button to display the Thicken Mesh dialog. 

 

3 Enter a Thickness to set the thickness required for the mesh. 

4 Select the Direction: 

 Inward — Select this option to apply the whole thickness in the 

inward direction. 

 Both — Select this option to apply half the thickness in each 

direction. 

 Outward — Select this option to apply the whole thickness in 

the outward direction. 

5 Select the Copy option to thicken a copy of the mesh and keep 

the original unchanged. 

6 Click OK to thicken the mesh and close the dialog. 
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Reduce the number of triangles 

This option is available only when using Delcam Designer or 
PowerSHAPE Pro. 

Use this option to reduce the number of triangles in the model. 

1 Select one or more meshes to display the Mesh Edit toolbar. 

2 Click the Reduce Mesh  button to display the Reduce Mesh 

dialog. 

 

3 Specify the reduction parameters using one of the following 

methods: 

 To percentage of original — Enter the percentage of the original 

number of triangles to be in the mesh. 

For example, enter 75. The number of triangles in the mesh is 

reduced by 25%, resulting in a less smooth mesh. 

 

 To number of triangles — Enter the target number of triangles 

for the resulting mesh. 



 

PowerSHAPE 2016 Reference Help Mesh modelling • 23  

 To tolerance — Select this option and enter a tolerance to 

reduce the number of triangles. Optionally select Limit triangle 

edge length to specify the maximum edge length of triangles 

in the reduced mesh. 

4 Click Apply to reduce the number of triangles in the mesh. The 

dialog remains open; you can change the values in the dialog to 

reduce the number of triangle again.  

5 Click Cancel to close the dialog. 
 

Refine mesh 

This option is available only when using Delcam Designer or 
PowerSHAPE Pro. 

Use Refine Mesh to increase the density of triangles in the mesh by 

dividing each triangle into four new triangles.  

The triangles are refined by curving the original triangles to create a 
smooth mesh. You can refine the mesh using a selected area or the 

whole mesh. This is useful for improving the smoothness of the 
mesh and can also be useful for subsequent operations (wrapping 

for example) that give better quality results on a higher density 
mesh. 

1 Select a mesh. 

2 Click the Refine Mesh  button to display the Refine Mesh 

dialog. The number of triangles in the selection or whole mesh is 

displayed, and you can change your selection while the dialog is 

open. Use this dialog to specify the method used to refine the 
triangles in a mesh. 

 

3 Choose the Refine Method to be used to calculate the vertices of 

the new triangles: 
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 Select Split each edge to subdivide each triangle into four new 

triangles by inserting new vertices in the middle of each edge. 

 Select Split edges greater than to subdivide triangles by 

inserting a new vertex in the middle of an edge when the 

length of the edge is greater than the specified value. 

 Select Split by aspect ratio to subdivide triangles with an 

aspect ratio of less than the specified value. The aspect ratio 
is the ratio of the height of the triangle divided by the length 

of the edge. 

4 Select Split boundary to indicate that the triangles on the 

boundary edge are to be changed. The examples below show the 

effect of using this option. 

Split boundary deselected: 

 

Split boundary selected: 
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5 Select Smooth by tolerance to smooth the refined mesh by 

curving the triangles. Enter a value for the tolerance. The higher 
the tolerance, the more curved refinement will be possible, 

resulting in a less faceted model. The vertices of the triangles are 
calculated on the curved triangle if the deviation between the 

curved and the flat triangle is less than the tolerance you 
specified. 

 

 Original triangle 

 Curved triangle 

 New triangle calculated on original triangle 

 New triangle calculated on curved triangle 

6 Click one of the following: 

 Apply to refine the mesh without closing the dialog box. If 

required, you can refine the mesh further. 

 Cancel to close the dialog. 
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Smooth mesh 

This option is available only when using Delcam Designer or 
PowerSHAPE Pro. 

Use Smooth mesh to smooth the triangles in the mesh.  

1 With a mesh selected, click the Smooth Mesh  button to 
display the Smooth Mesh dialog.  

 

Use this dialog to filter out noise in a mesh.  

2 Enter a Smoothing tolerance. This distance is used to determine 

the nodes that are affected by the smoothing process. 

 If required, right-click Smoothing tolerance to display the 

calculator. 

In this example, a Smoothing Tolerance of 20 is used so that the 

results of smoothing are clearly visible. Normally a much lower 
figure is used. 

 

3 Click Apply to smooth the mesh and continue with smoothing. 

4 When smoothing is complete, click Cancel to close the dialog. 
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Paint triangles 

This option is available only when using Delcam Designer or 
PowerSHAPE Pro. 

1 Click the Paint Triangles  button to display the Paint Triangles 

dialog. 

 

2 Select the colour to paint the triangles, using one of the following 

methods: 

 Click the arrow  to display the colour palette 

 

and select the colour you want to use. If the colour you want 
is not displayed in the palette, click the Other button to display 

the Colour dialog. Create a custom colour by specifying the 
values for Hue, Sat (saturation), Lum (Luminosity), Red, 

Green, and Blue. 

 To use a colour that is already used in the mesh, click the Pick 

Colour  button and then pick colour on the mesh. The 

picked colour is displayed in the Use colour box. 

3 Choose the method of triangle selection (see page 17): 

 Select triangles with the same colour 

 Select triangle area to discontinuity angle (see page 18) 

 Select triangle area to local horizon angle (see page 18) 

 Select triangle area to distance (see page 20) 
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4 Pick the triangles using your chosen method. The triangles are 

painted in the colour indicated in the dialog. 

 

5 If required, use  to remove the colour from the selected 

triangles in the mesh. 

 Selecting triangles and colouring them in this way is useful for 

dividing the mesh. Once the triangles are painted, use  to 

divide the mesh by colour. 
 

Morph mesh 

This option is available only when using Delcam Designer or 
PowerSHAPE Pro. 

Use the Morph flyout to change the shape of the mesh.  

 

Use the following buttons on the flyout to change the shape of the 
selected mesh: 

 Use morph techniques to change the shape of the mesh (see 

page 29). 

 Morph triangle regions that are defined by planes (see page 

30). 

 Morph triangle regions that are defined by curves (see page 

38). 
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General morphing 

1 Click the General Morph  button from the morphing flyout to 

display the Morphing dialog. This is the same as the dialog used 

with solid morphing. 

 

2 Use the tabs on the dialog to deform the active mesh into a 
different shape. 

 



 

30 • Mesh modelling PowerSHAPE 2016 Reference Help  

Morphing triangle regions defined by planes 

You can transform one or more regions of the model. The regions 

are defined by planes. 

1 Click the Morph using planes  button from the morphing 

flyout to display the Morph Triangles using Planes dialog. The 
options that are displayed on the dialog reflect the Transform 

region that is selected. 

 

Two planes are used to define the regions of the model.  

 

2 Adjust the position of a plane by double-clicking the plane and 
modifying the coordinates using the Plane dialog. 

3 Select an option from the Transform list: 

 None — Select this option to have no blending between the 

central region and the outer regions. This is the default 
option. 
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 Move — Select this option to move the region between the 

two planes. Enter X, Y, and Z values to indicate the amount to 

move along the axes. 

 Rotate — Select this option to rotate the region between the 

two planes. Enter a rotation Angle. Click the Reposition  

button to define a new rotation origin. 

 Scale — Select this option to increase or decrease the size of 

the region by entering a scale Factor. For example, to increase 

the size of the region by 20% enter a Factor of 1.2. By default, 

Factor is applied in all directions. Use the Lock  

buttons to suppress scaling in a specific axis. 

Click the Reposition  to define a new position for the scale 

origin. 

 Offset — Select this option to define the offset for the region. 

Enter an offset Distance. 

4 Specify the Blend Area to be used Before and After the transform 

region. Additional planes are added to the model that define the 

blend region.  

The following blend types are available: 

 None is the default setting. No blend is created between the 

transformed region and the adjoining regions . 

 

 Smooth creates a smooth curve between adjoining transform 

regions. The curve is tangential at both edges of the blend 

region. 
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 Linear creates a straight-line blend between the two transform 

regions. 

 

 Smooth to Sharp creates a smooth to sharp blend between the 

previous region and the current region. This creates a 

transition that uses a tangential curve next to the first 

transform region , and a linear blend next to the second 

transform region . 

 

 Sharp to Smooth creates a sharp to smooth blend between the 

previous region and the current region. This creates a 
transition that uses a linear blend next to the first transform 

region , and a tangential curve next to the second 

transform region . 

 

5 Use the buttons on the Regions Navigator to specify the region to 

be morphed. 

6 Click Preview to view the morph.  

7 Adjust the options as required. 

8 Click OK to morph the region. 
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Example of morphing triangles using planar regions 

1 Select the mesh. 

2 Click the Morph Using Planes  button to display the Morph 

Triangles by Planar Regions dialog. Planes are used to indicate the 

different regions on the model. 

 

3 Double-click the top plane to display the Plane dialog.  

4 Define the top plane as follows: 

a Set Z to 30. 

b Click OK to move the plane. 

5 Double-click the bottom plane to display the Plane dialog. 

6 Define the bottom plane as follows: 

a Set Z to 15. 
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b Click OK to move the plane. The top and bottom planes now 

look like this:  

 

7 Define the Transform region as follows: 

a Select Rotate from the list. 

b Set the Angle to 10. 

c Click Preview. 

The region between the two planes is rotated by 10 . 

 

8 Specify the Blend Area as follows: 

a Select Smooth from the Before list. 

b Select Linear from the After list. 

c Click Preview.  

The bottom blend between  and  is created using the 

smooth algorithm 
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The top blend, between  and  is created using the linear 

algorithm. 

 

9 Click the Previous Region  button to move to the bottom 

region, . 

10 Create an offset region as follows: 

a Select Offset from the Transform Region list. 

b Set Distance to 1. 

c Click Preview. 

Region  is offset by 1. 

 

11 Press Next Region  button twice to move to the top region . 

12 Create an offset region as follows: 

a Select Offset from the Transform list. 
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b Set Distance to 2. 

c Click Preview. 

Region  is offset by 2. 

 

13 Click OK to modify the model as follows: 

 Region  is rotated by 10 . 

 Bottom blend  uses the smooth algorithm. 

 Top blend  uses the linear algorithm. 

 Bottom region  is offset by 1. 
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 Top region  is offset by 2. 

 

14 Complete further morphing as required. 
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Morphing triangle regions defined by curves 

Morph regions on a model, using polygons to define the areas. 

Using polygons enables you to reshape up to three regions: 

 within an inner curve 

 outside an outer curve 

 between the two curves 

Using polygon regions 

1 Create the inner and outer polygons (see page 39). 

2 Use the following example to identify the regions and the curves 
on a mesh: 

 

 Inner transform region. 

 Inner curve. 

 Blend region. 

 Outer curve. 

 Outer transform region. 

Using this method, you can move a single point and blend the 
move into the rest of the model. This technique is useful 

counteract the sagging of the centre of a part after manufacture.  
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The example uses the centre of gravity to compensate for sag 

that occurs at the centre of a plate after it has been made. In 
this case the centre of the plate is moved by 2.0 and a smooth 

blend applied to the outer curve around the edge of the plate. 

3 Morph the regions using the Morph Triangles using Curves dialog 

(see page 40). 
 

Creating the inner and outer curves 

Use one of the following methods to create the inner and outer 

curves: 

 Sketch a curve on the model, using as many points as needed 

and click on the first point to close the curve. 

 Select an open model; the boundary is used as the curve. You 

can use triangle or closed polyline models.  

Use this option for the outer polygon, to create a curve around 

the boundary of the model. If you use this method, you can 
define an inner curve and blend from this to the edge of the 

model. 

 Select a single point for the inner curve. This has the effect of 

creating a blend region from the model's centre of gravity to the 

outer curve. 

 Use one of the options on the Morph triangles using Curves dialog 

(see page 40). 
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Morph Triangles using Curves dialog 

1 Select a mesh. 

2 Click the Morph Using Curves  button from the morphing 
flyout to display the Morph Triangles using Curves dialog. 

 

3 If necessary, use the following buttons to create the inner and 
outer regions. 

 Click the Snap to Mesh  button to create a curve that is 

snapped to the mesh (see page 103). 

 Click the Mesh Boundary  button to create a curve at the 

mesh boundary (see page 106). 

 With a curve selected, click the Offset  button to offset the 

selected curve. 

 Click the Centre of Gravity  button to add a point at the 

centre of gravity. 

4 Use Ctrl + click to select: 

 the Outer Item. 

 the Inner Items. 

The  changes to a  for both options. 

5 Select an option from the Transform the Inside list: 

 None — Select this option for no morphing of the inside 

region. This is the default. 
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 Move — Select this option to move the inside region. Enter X, 

Y, and Z values to indicate the amount to move along the 

axes. 

 Rotate — Select this option to rotate the inner region. Enter a 

rotation Angle. Click the Reposition  button to define a new 

rotation origin. 

 Scale — Select this option to increase or decrease the size of 

the region by entering a scale Factor. For example, to increase 

the size of the region by 20% enter a Factor of 1.2. By default, 

Factor is be applied in all directions. Use the Lock  

buttons to suppress scaling in a specific axis. 

Click the Reposition  to define a new position for the scale 

origin. 

 Offset — Select this option to define the offset for the region. 

Enter an offset Distance. 

6 Select the type of blend.  

The following blend types are available: 

 None is the default setting. No blend is created between the 

transformed region and the adjoining regions . 

 

 Smooth creates a smooth curve between adjoining transform 

regions. The curve is tangential at both edges of the blend 
region. 
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 Linear creates a straight-line blend between the two transform 

regions. 

 

 Smooth to Sharp creates a smooth to sharp blend between the 

previous region and the current region. This creates a 

transition that uses a tangential curve next to the first 

transform region , and a linear blend next to the second 

transform region . 

 

 Sharp to Smooth creates a sharp to smooth blend between the 

previous region and the current region. This creates a 
transition that uses a linear blend next to the first transform 

region , and a tangential curve next to the second 

transform region . 

 

7 Select an option from the Transform the Outside list: 

 None — Select this option for no morphing of the outside 

region. This is the default. 

 Move — Select this option to move the outside region. Enter X, 

Y, and Z values to indicate the amount to move along the 

axes. 

 Rotate — Select this option to rotate the outside region. Enter 

a rotation Angle. Click the Reposition  button to define a 

new rotation origin. 
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 Scale — Select this option to increase or decrease the size of 

the region by entering a scale Factor. For example, to increase 

the size of the region by 20% enter a Factor of 1.2. By default, 

Factor is be applied in all directions. Use the Lock  

buttons to suppress scaling in a specific axis. 

Click the Reposition  to define a new position for the scale 

origin. 

 Offset — Select this option to define the offset for the region. 

Enter an offset Distance. 

8 Click Preview to view the morph.  

9 Click OK to morph the region. 
 

Example of morphing triangle regions defined by curves 

 To see the effect of morphing, there must be sufficient 

triangles to allow the transform. The plane in the example 
below has been refined to increase the number of triangles. 

1 Select the mesh. 

 

2 Click the Morph Using Curves  button to display the Morph 

Triangle using Curves dialog (see page 40). 

3 Click  to select: 
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 Outer item  

 Inner item  

4 Select Move from the Transform the inside list. 

5 Enter a Z value of 5. 

6 Select Smooth as the Blend type. 

7 Click Preview. 

 

This shows the following changes: 

 The inner region is moved upwards by 5. 

 Blend area (between the two contours) is created using the 

smoothing algorithm. 

8 Select Scale from the Transform the outside list. 

9 Enter 1.5 as the scale Factor. 

10 Click the Lock X  button to lock the X axis. 

11 Click Preview. 

 

This shows that: 

 The outer region is scaled by 1.5.  

 The region is not scaled in the X direction. 
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Example of morphing triangle regions - contour and point 

 To see the effect of morphing, there must be sufficient 

triangles to allow the transform. The plane in the example 
below has been refined to increase the number of triangles. 

1 Select the mesh. 

 

2 Click the Morph Using Curves  button to display the Morph 

Triangle using Curves dialog (see page 40). 

3 Click the Centre of Gravity  button to highlight the centre of 

gravity. 

The point is highlighted in blue . 

4 Use Ctrl + click to select: 

 point . 

 outer contour . 

 

5 Select Linear from the Blend list. 

6 Select Move from the Transform the outside list. 

7 Enter a Z value of 10. 
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8 Click Preview to display the model. 

 

This shows that: 

 The inner region (the point) does not move. 

 The outer region is raised by 10. 

 The blend area is created using a linear blend. 
 

Segment mesh 

Use the segmentation functionality to identify the different regions 
of a mesh, and then create primitive or general surfaces to fit those 

regions. 

 Select an option from the Segmentation  flyout to segment 

and fit surfaces to a mesh. Use the following buttons to segment 
the mesh: 

 Automatically Segment (see page 47) 

 Manually Segment (see page 54) 

 Segmentation options are specified using the Mesh page of the 

Options dialog. 
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Automatically segment meshes 

Use automatic segmentation to quickly segment and fit multiple 

surfaces to a mesh. 

1 Select the mesh. 

 

2 Select Automatic segmentation from the segmentation flyout 

. 

 

3 Use the following options of the Segment Mesh dialog to control 

the segmentation process: 

 Use the slider  or enter a value  to edit the Similarity 

angle. 

 Lower similarity angles are useful to separate regions of 

high curvature on smooth meshes. Higher similarity 
angles are suited for coarser meshes with stronger 

discontinuities. 

 Enter a value for the surface matching tolerance . 

 Select which primitive geometries to use for segmentation, 

from the Primitive Types list . 

 Click  to display the Edit Extension dialog (see page 51).  
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 Click  followed by preview to Reclaim regions which have 

had primitives fitted to them.   

 Click  to display the Segmentation Settings dialog (see page 

51).  

 Click /  to toggle between generating surfaces or solids. 

 Use the Fit flyout  to select the fit direction: 

 Fit inside — Select this option so that the primitive surface 

is fitted to lie just below the inside of the mesh. 

 Fit through middle — Select this option so that the 

primitive surface is fitted as close as possible to the centre of 
the mesh. 

 Fit outside — Select this option so that the primitive 

surface is fitted to lie just above the outside of the mesh. 

 Click  to display the Manually segment mesh toolbar (see 

page 54). 

 Select Blank applied items  to automatically blank any 

applied surfaces or solids. 
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4 Click Preview to display a preview of the generated items. 

 

 Move the mouse over the generated item to display the fit 
tolerance. 

 If you change any of the options in the dialog you must 
click Preview again to update the preview. 

5 Select the generated items you want to keep using , and 
click Apply to create the items. 

 

 Using  on the item performs the same action as 
clicking Apply. 

6 To create additional items that were not previously detected: 

a Change the Similarity angle from the Segment mesh dialog. 
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b Click Preview. 

c Select the items and click Apply. 

7 Close the dialog and blank the mesh, leaving the newly created 

items. 

 

 Previously selected surfaces are remembered if you exit and 
then re-enter the segmenter for the same mesh. 

If any of the surfaces are deleted before returning to the 
segmenter, their regions are freed. 

If you undo, redo, or modify the mesh in any way, the persisted 
data will most likely be lost. For these circumstances the 

segmenter won't be able to remember which surfaces it 
produced. 
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Edit Extension dialog 

The Edit Extension dialog enables to you to edit extension distances 

of surfaces fitted to mesh models.  

To edit the extension distances of fit surfaces: 

1 Click the Edit extension distances  button on the Segment Mesh 

dialog. The Edit Extension dialog is displayed: 

 

2 Select the surfaces you want to edit. Left-click to select a single 
surface. Hold down the Shift key and left-click to select multiple 

surfaces or drag a box over your selection. 

3 Enter a new Extension distance value to define the distance by 

which the surfaces are extended beyond the edge of the regions. 

4 Click Apply to update the extension distance of the selected 

surfaces.  

5 Click Cancel to close the dialog. This discards any unapplied 

changes. 

 This is in contrast to editing extension distances using the 
options on the Segmentation Settings dialog (see page 51), 

which applies the edit to all surfaces or solids in your model. 
 

Segmentation Settings dialog 

The Segmentation Settings dialog enables you to control common 

segmentation settings for manual and automatic segmentation 

operations. 

To change the settings for manual and automatic segmentation 

operations: 

1 Click the Segmentation settings  button on the Segment Mesh 
dialog. The Segmentation Settings dialog is displayed. 
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2 Use the General tab to: 

 

 Click and drag the Item transparency slider to change the 

transparency of the fit surfaces when previewed.  

 Select Blank applied items to automatically blank any applied 

surfaces. If deselected, the transparency setting chosen above 
will determine the appearance of applied surfaces.    

 This check box is also available on the Segment Mesh 

dialog. 

 

3 Use the Fit Method tab to: 

 

 Edit the Surface alignment angle to define the tolerance for 

aligning primitive surfaces with a principal plane. 

 Edit the Surface extension distance to define the distance by 

which a primitive surface is extended beyond the edge of its 

region. 

 This is applied to all surfaces in the model, in contrast to 
the Edit Extension dialog (see page 51) which requires a 

selection of surfaces.  
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 Select the Trim surfaces option to create trimmed surfaces 

when segmenting.  

 Repeat for Solid alignment angle and Solid extension distance 

as required. 

 These options are also found in Tools > Options > Object > 

Mesh and can now be changed independently for surfaces 

and solids. 

 

4 To use the Shrink-wrap tab: 

 Click the Manually segment mesh  button to display the 

options: 

 

 Click and drag the U-direction patches slider, or enter an exact 

value, to define the number of U direction control points used 

to generate the surface curves in 2D space.  

 Click and drag the V-direction patches slider, or enter an exact 

value, to define the number of V direction control points used 

to generate the surface curves in 2D space.  

 Click  to edit the number of control points in both directions 

equally.  

 Click and drag the Angle slider to manually orientate the 

shrink-wrap surface.  

 These options are the same as those on the Shrink-wrap 

mesh dialog, accessed on the Mesh Edit toolbar.  

 

 The Segmentation settings  button is now common to the 

Automatic and Manual segmentation options. 
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Manually segment meshes 

Use manual segmentation to individually segment and fit surfaces to 

a mesh. 

1 Select the mesh. 

 

2 Select Manual segmentation  from the segmentation flyout 

. 

 

3 Use the following options of the Manually Segment Mesh toolbar to 

control the segmentation: 

 

 Use the Type drop-down list  to select the item type to fit. 

Plane — surface only 

Cylinder 

Cone 

Sphere 

Torus 

Extrusion 
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Revolution — surface only 

Shrink-wrap — surface only 

 Click  to display the Segmentation Settings dialog (see page 

51). 

 Click /  to toggle between generating surfaces or solids. 

 Use the Fit flyout  to select the fit direction: 

 Fit inside — Select this option so that the primitive surface 

is fitted to lie just below the inside of the mesh. 

 

This example is exaggerated to highlight the effects of different fit 
directions. 
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 Fit through middle — Select this option so that the 

primitive surface is fitted as close as possible to the centre of 

the mesh. 

 

This example is exaggerated to highlight the effects of different fit 

directions. 

 Fit outside — Select this option so that the primitive 

surface is fitted to lie just above the outside of the mesh. 

 

This example is exaggerated to highlight the effects of different fit 

directions. 

 



 

PowerSHAPE 2016 Reference Help Mesh modelling • 57  

1 Select an area of triangles on the mesh using the triangle 

selection tools. 

 

2 Click Preview to display a preview of the generated items on the 

model. 

 

 Move the mouse over the generated item to display the fit 

tolerance. 

3 Click to accept and blank the item. Alternatively click  to cancel 

the preview, and close the dialog. 
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 Using  on the item performs the same action as 

clicking . 

4 Close the dialog to view the newly created items. 

 

 Previously selected surfaces are remembered if you exit and 
then re-enter the segmenter for the same mesh. 

If any of the surfaces are deleted before returning to the 
segmenter, their regions are freed. 

If you undo, redo, or modify the mesh in any way, the persisted 

data will most likely be lost.For these circumstances the 
segmenter won't be able to remember which surfaces it 

produced. 
 

Shrink-wrap a surface onto a mesh 

You can generate a non-primitive surface and automatically trim it 
to fit a mesh using Shrink-wrap. 

1 Select the mesh to display the Mesh Edit toolbar. 

2 Use one of the selection tools to select the triangles to be shrink-

wrapped. 
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3 Select the triangles to shrink wrap 

 

4 Click Shrink-wrap a surface onto the selected mesh on the Mesh Edit 

toolbar. 

 

5 Use the following options on the Shrink-wrap Mesh dialog: 

 U-direction patches — use the slider, or enter an exact value to 

define the number of U direction control points used to 

generate the surface curves in 2D space. 

 V-direction patches — use the slider , or enter an exact value 

to define the number of V direction control points used to 

generate the surface curves in 2D space. 

 Click  to edit the number of control points in both 

parametric directions symmetrically . 

 For trivial meshes with simple curvature, fewer control 

points are needed. For non-trivial meshes with complex 
curvature, more control points are needed. 

 Angle — use the slider to manually orientate the shrink-wrap 

surface. 
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Before alignment 

 

After alignment 

 

 You can also click and drag the graphic handles  to rotate the 

surface around the temporary workplane . 

 

 A preview  is displayed that shows the lateral and longitudinal 

directions for the re-aligned surface. 

 

 Preview — click to get a preview of the surface. 

 OK — click to create the surface and close the dialog. 
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 Cancel — click to close the dialog with no changes. 

 

1 Click OK to create the surface. 

 
 

Dividing a mesh 

Use the options on the Divide mesh flyout to divide the mesh: 

 Divide mesh 

 Divide mesh by colour 

 Divide mesh by selection 

 

 
Divide mesh 

(see page 62) 
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Divide mesh by 

colour (see 

page 62) 

 
Divide mesh by 
selection (see 
page 64)  

 
 

Divide mesh 

Use this option to separate meshes.  

1 Select a mesh to display the Mesh Editing toolbar. 

 

2 Click the Divide Mesh  button on the Mesh Edit toolbar. 

The mesh is divided to create multiple meshes. 

 

 Divide Mesh asks for confirmation before dividing a mesh that 

consists of more than ten unconnected regions. 
 

Divide mesh by colour 

Use this option to separate meshes by colour. 

1 Select a mesh to display the Mesh Editing toolbar. 
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2 Use Paint Triangles to paint the area of the mesh that you wish to 

separate. 

 

3 With the mesh selected, click the Divide by Colour  button. 

The mesh is divided into three separate, selected meshes.  

 

4 Click away from the model. The boundary on the coloured areas 

changes to black. 

5 Right click each coloured area to check that the mesh has been 

separated. 
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Divide mesh by selection 

 This functionality is available only in PowerSHAPE Pro. 

1 Select a mesh to display the Mesh Editing toolbar. 

2 Use one of the selection methods to select the area of the mesh 
that you wish to separate. 

 

3 Click the Divide by Selection  button. The mesh is divided into 

two separate, selected meshes.  
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4 Right-click each area to check that the mesh has been separated. 

 
 

Reverse a mesh 

Use this option to reverse the direction of the triangles in the 
selected mesh. 

1 Select one or more meshes to display the Mesh Edit toolbar. 

 

2 Click the Reverse Mesh  button on the Mesh Edit toolbar. 
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Fixing faults in a mesh 

This option is available only when using Delcam Designer or 
PowerSHAPE Pro. 

Fix faults in a mesh using the Mesh Doctor. The following are classed 

as faults: 

 small and thin triangles 

 bad aspect ratio 

 badly connected triangles 

 overlaps 

 gaps 

 holes 

 intersecting triangles 

These problems need to be corrected to ensure that the mesh is as 

accurate and smooth as possible. 

For further details, see:  

 Mesh Doctor flyout (see page 66) 

 Using the Mesh Doctor to fix the mesh (see page 68) 

 Mesh Doctor dialog (see page 69) 

 List of fault options (see page 71) 
 

Mesh Doctor flyout 

Use the options on the Mesh Doctor flyout to check and fix a specific 

fault type: 
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1 Click on one of the following buttons to fix a particular type of 

fault. 

  

Mesh Doctor — Click this button 

to open the Mesh Doctor (see 
page 68)  

 
Bad Connections — Click this 

button to fix bad connections 

 
Open Boundaries — Click this 

button to fix open boundaries. 

 
Aspect Ratio — Click this button 

to fix triangles with bad aspect 
ratio by swapping the edges with 

a neighbouring triangle. 

 
Small Triangles — Click this 

button to fix small triangles. 

 
Intersections — Click this button 

to fix intersecting triangles. 

 
Overlaps — Click this button to 

fix overlapping triangles. 

 
Status — Click this button to 

display a summary of the faults 
in the mesh. 

 

2 Use the Mesh Doctor dialog to fix the mesh (see page 69). 

If you click  the Mesh Doctor detects and fixes all types of 

faults. If you click other options on the Mesh Doctor flyout, the 
Mesh Doctor identifies and fixes only the fault type that you have 

selected. 
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Using the Mesh Doctor to fix the mesh 

Mesh Doctor works in a similar way to Solid Doctor; it finds faults 

and tries to fix them. 

1 Select one or more meshes to display the Mesh Edit toolbar. 

2 Click the Mesh Doctor  button on the Mesh Edit toolbar to 

display the Mesh Doctor dialog (see page 69). 

 

The Mesh Doctor checks faults in the following order: 

a Badly connected triangles 

b Gaps  

c Holes 

d Small and thin triangles 

e Bad aspect ratio triangles 

f Intersections 

g Overlaps 

The faults are listed in the fault tree and displayed in pink on the 
model. You must fix faults in the order they are listed. If there 

are more than fifty faults of the same type, the Mesh Doctor 
merges them into a single superfault in the fault tree. 

 

3 Select the first branch in the fault tree. The Mesh Doctor must fix 

this type of fault first. 

4 Ensure that Attempt automatic repair is selected. 
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5 Click the Process  button to process the repair. On the mesh, 

the faults that have been repaired and the corresponding fault 
labels turn green. Fault has been repaired is displayed in green at 

the top of the information window in the dialog.  

6 Click the Re-check  button to re-check the model. Only faults 

that still need fixing are displayed. Comparing this to the original 

shows that many of the faults have been fixed using the 
automatic repair feature. 

7 If there are still faults, try using other options on the fault repair 
drop-down list. Fix all the faults of one type before fixing other 

types of fault. 

8 When all faults are fixed, click Finish. 
 

Mesh Doctor dialog 

Use the dialog to fix all the faults in a mesh. Resize the dialog as 

required, so that you can see the fault list. 

 

The Fault Tree is displayed in the left panel of the dialog and lists the 

faults in the mesh.  

 

You can select faults in the Fault Tree or the model window: 
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 If you select a fault in the tree, it is highlighted in the model.  

 

 If you select a fault label or fault annotation in the mesh, it 
highlighted in the tree.  

Fault Information for the selected fault is displayed in the right panel 

of the dialog.  

 

The following fault information is provided: 

 What is wrong: shows a description of the fault. 

 What to do: gives a suggested repair procedure. 

 Failed repair operations lists the fixing operation that failed. 

Fixing stage graphics show the progress on fixing faults. 

 

Viewing and saving the model: 

 Click the Zoom  button to zoom into the selected fault. Zoom 

out to view the whole solid. 

 Toggle the fault view: 
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 Selected Fault — Display this icon to highlight the selected 

fault only. 

 All Faults — Display this icon to highlight all the faults. 

 Click the Save  button to save the mesh with a different 

filename. 

Repair Options — Select a repair option from the list of available 
repair operations. The default option is Attempt automatic repair. 

Click the drop-down list to see the see list of repair options (see 

page 71).  

 Process — Click this button to apply the repair option to the 

selected faults. 

 Undo — Click this button to undo each repair operation.  

 Re-check — Click this button to re-check the mesh for faults. 

Finish — Click this button to close the dialog and re-check for faults. 

If faults are found the Faulty Mesh Query dialog is displayed. 
 

List of fault options 

This lists the repair options displayed in the Mesh Doctor dialog (see 

page 69). The repair options relevant to the selected fault are 
displayed in the Repair Options drop-down list. 

Repair option Action 

Attempt automatic repair Try to resolve the fault 
automatically. 

Fill hole with curvature cap 

Fill gap with new triangle 

Fill the hole with a curvature 

matching cap. 

Fill hole with planar cap Fill the hole with a planar cap. 

Mark hole boundary with 
curve for manual fixing 

Create a curve around the fault 

triangles, holes, or gaps. 

Ignore intentional large hole 

Ignore triangles with bad 
aspect ratio 

Ignore thin triangles 

Ignore small triangles 

Ignore this fault. 

Delete triangles Delete all triangles that form 
the fault. 
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Delete smallest triangle in this 
fault 

Delete the smallest triangle 

within this fault. 

Link boundaries across gap 

Close gaps by stitching 
across open boundaries 

Stitch the gap boundaries of 
this fault. 

Fix by merging nodes that 
form small triangles 

Fix by merging nodes 

Merge (stitch) nodes of this 
fault. 

Remove thin triangles and 
stitch across gap 

Delete the triangles of this fault 

and stitch across the created 
gap. 
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Fill holes 

This option is available only when using Delcam Designer or 
PowerSHAPE Pro. 

Click the Fill Holes  button to fill holes in the model by selecting 

the open boundaries. 

If the hole to be filled covers an area of different curvature, split the 

hole into smaller regions, and fill them separately. This allows more 
complicated holes to be fixed without the need for full manual 

triangle-editing. After selecting a hole to fill, you can pick two points 
on the boundary to split the hole into two regions. If the wrong side 

is highlighted by default, click to select the region that you want to 
fill. 

For example, using the plate.stl example file supplied with 

PowerSHAPE, fill the hole in two parts, filling the flat area with a 

planar cap, and the curved area with a curvature cap. 

 

1 Select a mesh to display the Mesh Edit toolbar. 

2 Click the Fill Holes  button to open the Fill Holes dialog. 
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3 Select holes to fill in one of the following ways: 

 Box selection: 

Use the following key and box selection techniques to select 
holes to be filled in a selected mesh: 

Shift and box selection to add the selection to the set of 

selected holes. 

Ctrl and box selection to invert the selection status of holes 

intersected by the box. 

Box selection without Ctrl or Shift adds holes intersected by 

the box to the set of selection holes. All holes that are not 
intersected by the box are removed from the selection. 

 Boundary selection:  

(a) Select the hole by clicking its boundary . The selected 

boundary turns blue. 
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(b) Select two points to specify part of hole you want to fill 

first. A mark is added at the position of the first point. A line 
connects the first point to the second point. The area to be 

filled is outlined as a blue hole . The alternative selection is 

outlined by a dashed blue line . Swap the selection by 

clicking the outline of the region required. 

 

4 Select one of the following Mode options: 

 Curvature cap calculates the curvature needed to fill the hole 

by examining the surrounding triangles. New nodes are 
generated on the curved area. New triangles are generated 

using the boundary nodes and the new nodes.  

 Planar cap generates a nominal plane that passes through the 

boundary nodes (approximately if the boundary is not planar). 

New nodes that are within the boundary are generated on the 
plane. New triangles are generated using the boundary nodes 

and the new nodes. 

The examples below show how important it is to select the 
correct Mode option. The example shows that in this case, as the 
hole is on a curved area, you should use the Curvature cap 

option. 

 Hole filled with a Curvature cap 
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 Hole filled with a Planar cap 

The average length between nodes surrounding the hole is 
displayed in the Distance between cap nodes. This value is used to 

determine the density of the new nodes. Change the value as 

required. 

5 Click Apply to apply the changes you have made and leave the 

dialog displayed to continue filling holes. 

6 Click Cancel when you have finished filling the hole. 
 

Stitch mesh 

This option is available only when using Delcam Designer or 
PowerSHAPE Pro. 

1 Select one or more meshes to display the Mesh Edit toolbar. 

2 Click the Stitch Mesh  button on the Mesh Edit toolbar to open 
the Stitch Mesh dialog. 

 

3 Select the Iteration Mode: 

 Single pass runs the stitch once at the given tolerance. 

 Multiple pass runs the stitch algorithm with the given number 

of steps, using logarithmic progression between the start and 
end tolerance. This is the default Iteration mode. 



 

PowerSHAPE 2016 Reference Help Mesh modelling • 77  

4 Set the Start tolerance. This is the initial tolerance you want to 

use for stitching. 

5 Set the End tolerance. This is the final tolerance you want to use 

for stitching.  

6 Set the Number of steps to be used when stitching. 

7 Select the Stitch Mode: 

 Stitch boundary nodes (default option) restricts the stitch 

operation to the boundary nodes. 

 Stitch full mesh runs the stitch operation on the whole mesh. 

With this option selected, select one of the following to specify 

the stitch method: 

Remove coincident nodes and collapsed triangles 

Combine selected meshes. 

8 Click OK. 

Initially using the Start tolerance, boundaries that are close together 

(compared with the tolerance) are stitched by generating new 

triangles to join the boundaries together. The tolerance is then 
increased and the stitching process is repeated. This sequence 
continues until either the mesh is closed, or the End Tolerance is 

reached. 

 Stitching is applicable only where boundaries are close 

together. The start and end tolerance determine if it is 
possible to stitch the mesh. If the boundaries are too far 

apart, it is not possible to stitch the mesh. If there are 

sizeable holes in the mesh, use Fill holes (see page 73) . 
 

Resolve overlapping triangles 

This option is available only when using Delcam Designer or 
PowerSHAPE Pro. 

Use this option to remove overlapping triangles in the selected 
meshes. 

1 Select one or more meshes to display the Mesh Edit toolbar. 
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2 Click the Resolve Overlaps  button to delete overlapping 

triangles. 

 
 

Z-compensation tool 

This option is available only when using Delcam Designer or 
PowerSHAPE Pro. 

Use the Z-compensation tool to cancel the overcure effect when 

preparing meshes for manufacture on stereolithography machines. 

1 Create a solid sphere. 

2 Click the Create Meshes  button on the Solid Edit toolbar to 

convert the solid to triangles. 

3 Select the mesh to display the Mesh Edit toolbar. 

4 Click the Z Compensation  button to display the Z 

Compensation dialog. 

 

5 Enter an Amount.  
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6 Click Apply to display the model with the compensation applied. 

 

 

 In the example a large value is used to exaggerate the effect. 
 

Masking triangles on a mesh 

Use the buttons on the Mask flyout to: 

 Mask selected triangles on a mesh (see page 79). 

 Unmask selected triangles on a mesh (see page 80). 

 Unmask all triangles on a mesh (see page 81). 
 

Mask selected triangles on a mesh 

1 Select a mesh. 

2 Hover the mouse over  to display the buttons on the Mask 

flyout. 
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3 Click the Mask  button to mask selected triangles on a mesh. 

Masked triangles are hidden and drawn as transparent. They are 

not used in subsequent operations until they are unmasked.  

 
 

Unmask selected triangles on a mesh 

1 Select a mesh. 

2 Hover the mouse over  to display the buttons on the Mask 

flyout. 

 

3 Click the Unmask Selected  button to unmask the selected 

triangles on a mesh, which enables you to use them. 
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Unmasking all triangles on a mesh 

1 Select a mesh. 

2 Hover the mouse over  to display the buttons on the Mask 

flyout. 

 

3 Click the Unmask All  button to unmasks all triangles on a 

mesh, which enables you to use them.  
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Add triangle 

Select the Add Triangle  button to add triangles to the model by 

clicking on existing triangle vertices.  

1 Select a mesh. 

A section of the mesh shown below has some missing triangles: 

 

2 Select the Add Triangle  button. 

3 Select the first point (or vertex) with the left mouse button . 

This point is marked in blue. 

 

4 Select the second point . 

5 Select the last point .  
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The new triangle is drawn. Open edges that don't match the 

existing triangles are drawn in yellow. 

 

6 Add further triangles as required. 

7 When you have finished adding triangles deselect the Add 

Triangle  button. 
 

Delete triangles 

Use Delete Triangles  to delete the selected triangles in the 

model. 

1 Select the triangles you want to delete. The selected triangles 

turn blue. 
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2 Click Delete Triangles . This removes the selected triangles 
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Sculpt meshes 

Use Sculpt meshes  to change the shape of the mesh: 

1 Click the Sculpt meshes  button in the General Edits toolbar to 
open the Sculpting toolbar. By default, the toolbar is floating, but 

you can dock it. 

 

2 Select one of the following operations: 

 Add material (see page 86) 

 Remove material (see page 87) 

 Smooth (see page 88) 

 Erase (see page 89) 

3 Use the following to adjust the brush: 

 Brush diameter — Select the button and drag the slider (or D 

+ mouse scroll wheel) to increase or decrease the size of the 

brush. 

 Strength — Select the button and drag the slider (or H + 

mouse scroll wheel) to increase or decrease the amount each 

node is raised or lowered as a percentage of the brush radius. 

 Brush Smoothness — Select the button and use the slider (or 
M + mouse scroll wheel) to increase or decrease the smoothness 

of the area you are sculpting. The smoothness determines 

whether there is any reduction in the strength towards the edges 

of the brush.  

A setting of 0% maintains full strength right to the edge of the 

brush.  

A setting of 100% smooths the material across the diameter of 

the brush. 
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 Use the slider to enter the value to be 

associated with the button you have selected. 

4 Use the following to specify maximum deviation and length: 

 Limit deviation — Select the button and enter the 

maximum deviation that the nodes can move. 

 Refine triangles — Select the button and enter the 

maximum length to be used when refining triangles. 

 Show deviations (see page 90) — Select this button to see 

the difference between the original and sculpted models when 
using the editing tools. Deselect it to hide the differences. 

Move the cursor over the model to make the required changes. 

When you have finished editing, click the Exit  button to close 

the toolbar. 

This functionality is also available by selecting Edit > General Edits > 

Sculpt Meshes. 

 Use Undo and Redo (Main toolbar) to undo/redo the last 
action. 

 

Sculpting triangles - Add material 

Use Add material , in combination with the brush tools, to add 
material. Using Add material does not increase the number of 

triangles, but lifts the existing nodes. The orientation of the model 
affects the way the area is built up. To undo the add action, use the 
Erase option. 

1 Use the following to adjust the brush: 

 Brush diameter — Select the button and drag the slider (or D 

+ mouse scroll wheel) to increase or decrease the size of the 

brush. 

 Strength — Select the button and drag the slider (or H + 

mouse scroll wheel) to increase or decrease the amount each 
node is raised or lowered as a percentage of the brush radius. 
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 Brush Smoothness — Select the button and use the slider (or 
M + mouse scroll wheel) to increase or decrease the smoothness 

of the area you are sculpting. The smoothness determines 
whether there is any reduction in the strength towards the edges 

of the brush.  

A setting of 0% maintains full strength right to the edge of the 
brush.  

A setting of 100% smooths the material across the diameter of 
the brush. 

 Use the slider to enter the value to be 

associated with the button you have selected. 

2 Use the following to specify maximum deviation and length: 

 Limit deviation — Select the button and enter the 

maximum deviation that the nodes can move. 

 Refine triangles — Select the button and enter the 

maximum length to be used when refining triangles. 

 Show deviations (see page 90) — Select this button to see 

the difference between the original and sculpted models when 

using the editing tools. Deselect it to hide the differences. 

 Move the cursor over the model to make the required 

changes. When you have finished editing, click the Exit  

button to close the toolbar. 
 

Sculpting triangles - Remove material 

Use Remove material , with the brush tools, to lower the triangle 

nodes under the brush, to make it look as though material has been 
carved out of the model. To undo the remove action, use the Erase 

option. 

1 Use the following to adjust the brush: 

 Brush diameter — Select the button and drag the slider (or D 

+ mouse scroll wheel) to increase or decrease the size of the 
brush. 
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 Strength — Select the button and drag the slider (or H + 

mouse scroll wheel) to increase or decrease the amount each 

node is raised or lowered as a percentage of the brush radius. 

 Brush Smoothness — Select the button and use the slider (or 
M + mouse scroll wheel) to increase or decrease the smoothness 

of the area you are sculpting. The smoothness determines 

whether there is any reduction in the strength towards the edges 
of the brush.  

A setting of 0% maintains full strength right to the edge of the 
brush.  

A setting of 100% smooths the material across the diameter of 
the brush. 

 Use the slider to enter the value to be 

associated with the button you have selected. 

2 Use the following to specify maximum deviation and length: 

 Limit deviation — Select the button and enter the 

maximum deviation that the nodes can move. 

 Refine triangles — Select the button and enter the 

maximum length to be used when refining triangles. 

 Show deviations (see page 90) — Select this button to see 

the difference between the original and sculpted models when 
using the editing tools. Deselect it to hide the differences. 

 Move the cursor over the model to make the required 

changes. When you have finished editing, click the Exit  

button to close the toolbar. 
 

Sculpting triangles - Smooth 

Use Smooth  to smooth out irregularities in the triangle nodes. 

For each node in the smoothing area, PowerSHAPE calculates a 
position based on the surrounding nodes. 

1 Use the following to adjust the brush: 

 Brush diameter — Select the button and drag the slider (or D 

+ mouse scroll wheel) to increase or decrease the size of the 

brush. 
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 Strength — Select the button and drag the slider (or H + 

mouse scroll wheel) to increase or decrease the amount each 

node is raised or lowered as a percentage of the brush radius. 

 Brush Smoothness — Select the button and use the slider (or 
M + mouse scroll wheel) to increase or decrease the smoothness 

of the area you are sculpting. The smoothness determines 

whether there is any reduction in the strength towards the edges 
of the brush.  

A setting of 0% maintains full strength right to the edge of the 
brush.  

A setting of 100% smooths the material across the diameter of 
the brush. 

 Use the slider to enter the value to be 

associated with the button you have selected. 

2 Use the following to specify maximum deviation and length: 

 Limit deviation — Select the button and enter the 

maximum deviation that the nodes can move. 

 Refine triangles — Select the button and enter the 

maximum length to be used when refining triangles. 

 Show deviations (see page 90) — Select this button to see 

the difference between the original and sculpted models when 
using the editing tools. Deselect it to hide the differences. 

 Move the cursor over the model to make the required 

changes. When you have finished editing, click the Exit  

button to close the toolbar. 
 

Sculpting triangles - Erase 

Use Erase , in combination with the Strength, to undo changes 

that you have made during the current editing session. Set Strength 

to 100% to move the node to its original position in one step. Set 

the option to 50% to move the node to its original position in two 
steps. 

1 Use the following to adjust the brush: 
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 Brush diameter — Select the button and drag the slider (or D 

+ mouse scroll wheel) to increase or decrease the size of the 

brush. 

 Strength — Select the button and drag the slider (or H + 

mouse scroll wheel) to increase or decrease the amount each 

node is raised or lowered as a percentage of the brush radius. 

 Brush Smoothness — Select the button and use the slider (or 
M + mouse scroll wheel) to increase or decrease the smoothness 

of the area you are sculpting. The smoothness determines 

whether there is any reduction in the strength towards the edges 

of the brush.  

A setting of 0% maintains full strength right to the edge of the 

brush.  

A setting of 100% smooths the material across the diameter of 

the brush. 

 Use the slider to enter the value to be 

associated with the button you have selected. 

2 Use the following to specify maximum deviation and length: 

 Limit deviation — Select the button and enter the 

maximum deviation that the nodes can move. 

 Refine triangles — Select the button and enter the 

maximum length to be used when refining triangles. 

 Show deviations (see page 90) — Select this button to see 

the difference between the original and sculpted models when 
using the editing tools. Deselect it to hide the differences. 

 Move the cursor over the model to make the required 

changes. When you have finished editing, click the Exit  

button to close the toolbar. 
 

Sculpting triangles - Show deviations 

Use Show Deviations  to see the difference between the original 

and sculpted models when using the editing tools. 

1 Select a mesh. 
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2 On the General Edits toolbar click the Sculpt Meshes  button 
to display the Sculpting toolbar. 

3 On the Sculpting toolbar, select the Add Material  option and 

move the mouse to add material to the mesh. 

 

4 Select the Show Deviations  option to see the difference 

between the original and the sculpted model. The analysis scale 
enables you to see the percentage of material that you have 

added to the model. 

 

Alternatively, select Show Deviations  before adding the 

material to see the dynamic changes. 
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Combining selected meshes 
Use this option to combine selected meshes. 

1 Select one or more meshes to display the Mesh Edit toolbar. 

 

2 Select Object > Mesh > Combine. 

The meshes are joined to create a single mesh. 
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Shading meshes 
On the Views toolbar, use the options on the Mesh representation 

flyout to shade meshes: 

1 Select a mesh.  

The following section is used to show the effect of the different 

buttons: 

 

2 Right-click  on the Views toolbar to display the Mesh 

representation flyout. 

 

3 Select each button in turn to see the effect on the model. 
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 Nodes and open edges, hollow — Select this option to display 

nodes and open edges over hollow triangles. 

 

 The graphic above has been magnified so that the nodes 
are visible. 

 Open and interior edges, hollow — Select this option to 

display open and interior edges over hollow triangles. 

 

 Nodes and open edges, shaded — Select this option to display 

nodes and open edges over shaded triangles. 
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 Open and interior edges, shaded — Select this option to 

display open and interior edges over shaded triangles. 

 

 Open edges only — Select this option to show meshes as 

open edges only. 
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Renaming a mesh 
To rename a mesh: 

1 Select one of the following: 

 Select Object > Mesh > Rename. 

 Select Rename mesh from the Mesh context menu. 

 

The Rename Mesh dialog is displayed: 

 

2 Enter a name into the Name field. 

3 Click OK to rename the mesh. 
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Smooth shading of meshes 
You can smooth a mesh to improve the appearance of the faceted 
triangle mesh. You can use this option on imported files that contain 
triangles but do not contain normals, such as .stl, .dmt or .obj files.  

To use Smoothing 

1 Import a triangle file that does not contain normals. The example 
shown below is a .dmt file of part of a shoe sole.  

 

The appearance is faceted. 
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2 Click the Smooth Normals  button on the Mesh Edit toolbar. 

The Smooth Normals dialog (see page 98) is displayed where you 

specify the degree of smoothing required. 
 

Smooth Normals dialog 

Use this dialog to specify the degree of smoothing to improve the 
appearance of the triangle mesh on imported triangle files. 

 

Minimum inter-facet angle to be smoothed — When you first open the 
Smooth Normals dialog, the default smoothing setting is 

automatically selected. You can enter a new value or use the slider 

to reduce and increase the smoothness of the facets to control the 
appearance of the triangle mesh.  

The two examples below show the difference in the appearance 
of the facets. 

Imported .dmt file with no smoothing 

 

Imported .dmt file with smoothing applied 
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The appearance of the model is improved by reducing faceting 

whilst preserving the intentional sharp edges.  

 

The two examples below show the results of using extreme 

values.  

Small amount of smoothing  

In the example below, the angle value used is too small and 

many facets have not been smoothed, reducing the quality of the 
appearance. 

 

High amount of smoothing 

In the example below, the angle value used is too high and many 
intentional sharp edges have been smoothed, spoiling the 

appearance. 
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Smooth shade — Select this option to toggle Smooth Shading on or 

off. You can also toggle this option by right-clicking the model and 
selecting Smooth Shade from the Mesh context menu. 

OK — Applies the specified smoothing. 
 

Offsetting a mesh 
To offset a mesh: 

1 Select the mesh to offset. 

2 On the General Edits toolbar click the Offset object  button. 

3 On the Offset toolbar, select Round Discontinuities  and enter a 

Distance. 

The mesh is offset. 

 
 

Converting meshes 
Use the Mesh  context menu to complete the following conversion: 

Convert to mesh (see page 100) 

Convert a mesh to a solid (see page 102) 
 

Converting to meshes 

Convert a single solid to a mesh  

1 Select a solid. 

2 On the Solid Edit toolbar, click the Create Meshes  button. 

Convert a single or multiple solids 

1 Select one or more solids. 

2 Select Edit > Convert > Selection to Meshes. 

Convert a surface to a mesh 

1 Select one or more surfaces. 
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2 Right-click on the selection. 

3 Select Convert to Mesh from the menu.  

 

Alternatively, select Edit > Convert > Selection to Meshes. 

Convert a mixture of solids and surfaces to meshes 

1 Select the solids and surfaces. 

2 Select Edit > Convert > Selection to Meshes. 
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Converting a mesh to a solid 

Convert a mesh and a surface to a solid 

1 Select a mesh and a surface. 

2 Click Create solid from selection of surfaces or meshes  (Solid 

toolbar). 

A solid is created from the selected surface and mesh. 

Convert a mesh to a closed solid 

1 Select a mesh.  

2 Click the selection with the right mouse button to display the 
Mesh context menu. 

3 Select Cap open. 

 

A capped solid is created from the mesh. 
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Creating curves 
Use the Mesh options on the Curve toolbar to create curves from 

meshes: 

Curve snapped to mesh (see page 103). 

Curve at discontinuities in a mesh (see page 105). 

Curve from mesh boundary (see page 106). 
 

Create curve snapped to mesh 

Use this option to create a curve snapped to a mesh. 

1 Select a mesh. 

2 Click the Create Curve Snapped to Mesh  button on the Curve 

toolbar.  

 

The Create Curve Snapped to Triangles toolbar is displayed. 

 

3 Select one of the following options to specify the way the curve is 

created: 
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 Select To tolerance to automatically insert additional points so 

that the curve lies on the triangles to tolerance. The example 

below is to tolerance 0.01. 

 

 Select Insert extra points to create a fixed number of points per 

span. Enter the number of points in Value. If you enter a Value 

of zero to create a curve with zero breakpoints. The points will 

lie on the triangles. Spans may not be within tolerance. 

The example below has 3 points per span. In this case, the 

highlighted area shows that the curve does not follow the 
triangles as accurately as using To Tolerance. 

 

4 Click the Insert Discontinuity  button to end the current curve 

at the previous point and start a new curve from the same point. 

The new curve is non-tangential to the first curve. 

5 Click the Save  button to finish the curve. 

6 Close the toolbar to view the curve and the points. 

This functionality is also available by selecting Object > Curve > Curve 

Snapped to Mesh. 
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Creating a curve at discontinuities in a mesh 

To create a curve on a mesh where discontinuities are greater than 

a certain angle: 

1 Select a mesh. 

 

2 Click the Create curve at discontinuities in mesh  button (Curve  

toolbar).  

 

The Mesh Discontinuities dialog is displayed. 

 

3 Enter the minimum discontinuity angle or click the right mouse 
button to open the Calculator. 

4 Click OK to create composite curves where the discontinuities are 

greater than the angle that you entered. 

 

This functionality is also available by selecting Object > Curve > 

Discontinuities from Mesh. 
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Create curves from mesh boundary 

To create a curve from a mesh boundary: 

1 Select a mesh or some triangles in a mesh. 

2 Click the Curve From Mesh Boundary  button on the Curve 
toolbar to display the curve and the Curve options dialog. 

 

3 Using the sliders on the dialog: 

 Adjust the Curve smoothness of the curve. If you wish to 
define the curve location, move the Curve Smoothness slider 

from the original position. 

 Define the Curve location. If the Curve smoothness slider is in 

the original position, moving this slider has no effect on the 

curve that is created. 

There are three positions for the curve: 

Outside — The curve is positioned so that it is enclosing all the 

selected triangles. 
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Average — The curve is positioned so that some triangles are 

within the curve and some are outside the curve. 

 

Inside — The curve is entirely inside the selected triangles. 

 

4 Complete the creation of the composite curve by: 

 Clicking Apply to create the composite curve, leaving the 

dialog displayed. Adjust the sliders as required. 

 Clicking OK to accept the changes and close the dialog. A 

composite curve is created from the mesh boundary.  

 

5 To view the composite curve: 

a Right-click the mesh. 
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b Select Blank from the context menu to blank the mesh. The 

composite curve remains. 

 

6 Edit the composite curve as required using graphical editing 

techniques. 
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Surface from triangles 
When creating a surface from the triangles in a mesh, the triangles 
used to create the surface will become masked. 

1 Select a mesh. 

 

2 Select the Surface From Mesh  button on the Surface toolbar. 

3 Create a surface from a mesh: 

 Pick points on the mesh to create a closed curve. When 

completing the curve,  is displayed when you move the 

cursor near the start point 

 Click  to define a corner at the last click point. 

 Use  to define a corner at the click point. 

 Use to add a straight section to the curve. 

The model below shows two surfaces created from the mesh. 
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Boolean operations 
Use Boolean operations to create a mesh from 

 two meshes 

 a solid and a mesh 

Two meshes 

Use the Boolean operations (Feature toolbar) to intersect, subtract, 

or combine two meshes.  

 

Create a mesh from the intersection of two meshes as follows: 

1 On the Feature toolbar, click the Intersect  button to display 
the Boolean Intersection dialog. 

2 Select  as the Primary selection and  as the Secondary 

selection. 

3 Click OK to create the new mesh. 

 



 

PowerSHAPE 2016 Reference Help Mesh modelling • 111  

Solid and mesh 

Use the Boolean operations on the Feature toolbar to intersect, 

subtract, or combine a solid and a mesh.  

 

Create a mesh by subtracting a mesh from a solid as follows: 

1 Click  Subtraction (Feature toolbar) to display the Boolean 

Subtraction dialog. 

2 Select  as the Primary selection and  as the Secondary 

selection. 

3 Deselect Keep original solids. 

4 Click OK to create the new mesh. 

5 Click Yes to delete the Feature tree, if it already exists. 

 

 


